**TI Designs**

**Low-Power PIR Motion Detector With Bluetooth® Smart and 10-Year Coin Cell Battery Life Reference Design**

**TI Designs**
This TI Design uses Texas Instruments’ nano-power operational amplifiers, comparators, and the SimpleLink™ multi-standard 2.4-GHz wireless microcontroller (MCU) platform to demonstrate an ultra-low-power motion detector, leading to extremely long battery life and no required wiring.

**Design Resources**

- TIDA-00759  
  Design Folder
- LPV521  
  Product Folder
- TLV3691  
  Product Folder
- CC2650  
  Product Folder

**Design Features**

- Use of Nano-Power Analog for Ultra-Low-Power Design Resulting in 10-Year Battery Life From Single CR2032 Coin Cell
- Low Shutdown Current of 1.63 μA (PIR Sensor Remains Active in Shutdown)
- Ultra-Low Active State Current Due to Low Active Processor and Radio Transmit Currents (1.57 mA for 56.66 ms)
- Interrupt Driven Bluetooth Smart Wireless Communication of Motion for Increased Power Savings
- Motion Sensitivity up to 30 ft

**Featured Applications**

- Building Automation
- Intrusion Detection
- Occupancy Detection
- Motion Detection
- Room Monitors
- Battery Powered Systems

---

An IMPORTANT NOTICE at the end of this TI reference design addresses authorized use, intellectual property matters and other important disclaimers and information.
## Key System Specifications

### Table 1. Key System Specifications

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>SPECIFICATIONS</th>
<th>DETAILS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input power source</td>
<td>CR2032 Lithium-ion coin cell battery (3.0-V nominal voltage)</td>
<td>Section 2.4</td>
</tr>
<tr>
<td>Sensor type</td>
<td>PIR (Pyroelectric or Passive InfraRed)</td>
<td>Section 2.5</td>
</tr>
<tr>
<td>Average active-state current consumption</td>
<td>1.57 mA</td>
<td>Section 8.1</td>
</tr>
<tr>
<td>Active-state duration</td>
<td>56.66 ms</td>
<td>Section 8.1</td>
</tr>
<tr>
<td>Average standby-state current consumption</td>
<td>2.97 µA</td>
<td>Section 8.1</td>
</tr>
<tr>
<td>Standby-state duration</td>
<td>1 minute of no motion detected</td>
<td>Section 4.4</td>
</tr>
<tr>
<td>Average shutdown-state current consumption</td>
<td>1.63 µA</td>
<td>Section 8.1</td>
</tr>
<tr>
<td>Movements per hour assumed for lifetime calculation</td>
<td>≥10 per hour average over the battery lifetime (worst case)</td>
<td>Section 8.2</td>
</tr>
<tr>
<td>Estimated battery life</td>
<td>&gt; 10 years</td>
<td>Section 8.2</td>
</tr>
<tr>
<td>Motion sensing range</td>
<td>30 feet nominal</td>
<td>Section 8.3.1</td>
</tr>
<tr>
<td>Radio transmission range</td>
<td>&gt; 54 meters</td>
<td>Section 8.3.2</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>−30°C to 60°C (limited by CR2032 coin cell operating range)</td>
<td>Section 2.4</td>
</tr>
<tr>
<td>Operating humidity</td>
<td>20 to 70%</td>
<td>Section 7.3.1</td>
</tr>
<tr>
<td>Vibration</td>
<td></td>
<td>Section 8.3.4</td>
</tr>
<tr>
<td>RF immunity</td>
<td>30 V/m from 10 kHz to 1 GHz</td>
<td>Section 8.3.3</td>
</tr>
<tr>
<td>Working environment</td>
<td>Indoor and outdoor</td>
<td>Section 2.4</td>
</tr>
<tr>
<td>Form factor</td>
<td>35×75-mm rectangular PCB</td>
<td>Section 9.5</td>
</tr>
</tbody>
</table>
2 System Description

Many industrial and building automation systems use motion detectors to control different functions based on human presence, such as lighting, for achieving higher efficiency of those functions by turning them off when not needed. Additionally, these systems require increasing numbers of wireless sensor nodes to reduce the installation costs and make the systems more flexible for future expansion by eliminating wiring. However, one of the major limitations for a large wireless network is power. Because these systems are battery powered, the maintenance cost associated with periodic battery replacement can become prohibitive. Depending on the power consumption and battery configuration, typical battery-powered PIR motion detectors can run anywhere from four to seven years before the batteries need to be replaced.

Enabled by Texas Instruments' nano-power amplifiers, comparators, and the SimpleLink ultra-low-power wireless MCU platform, the Low-Power PIR Motion Detector With Bluetooth® Smart and 10-Year Coin Cell Battery Life TI Design demonstrates a motion detector circuit solution requiring no wiring while also fully maximizing the battery life.

At a high level, this TI Design consists of a CR2032 coin cell battery, two nano-power op amps, two nano-power comparators, an ultra-low-power wireless MCU, and a PIR sensor with analog signal output. The two op amps form an amplified bandpass filter with a high input impedance, which allows it to be connected directly to the sensor without loading it. The two comparators form a window comparator, which is used to compare the amplified sensor output to fixed reference thresholds so that motion can be distinguished from noise. The two outputs of the window comparator then serve as interrupts to the wireless MCU so that the MCU can operate in its lowest power sleep mode during times where there is no motion being detected and only wakes up to send messages back to a remote host when motion has been detected. Due to the nano-amp operation of the analog signal chain components, this TI Design achieves a 10-year battery life from a single CR2032 coin cell battery.

This design guide addresses component selection, design theory, and the testing results of this TI Design system. The scope of this design guide gives system designers a head-start in integrating TI's nano-power analog components, and the SimpleLink ultra-low-power wireless MCU platform.

The following sub-sections describe the various blocks within the TI Design system and what characteristics are most critical to best implement the corresponding function.

2.1 Operational Amplifiers

In this TI Design, it is necessary to amplify and filter the signal at the output of the PIR sensor so that the signal amplitudes going into following stages in the signal chain are large enough to provide useful information.

Typical signal levels at the output of a PIR sensor are in the micro-volt range for motion of distant objects which exemplifies the need for amplification. The filtering function is necessary to primarily limit the noise bandwidth of the system before reaching the input to the window comparator. Secondarily, the filtering function also serves to set limits for the minimum and maximum speed at which the system will detect movement.

For an extremely long battery life, this TI Design uses the LPV521 because of its low current consumption of 351 nA (typical) per amplifier. Other considerations that make the LPV521 ideal for this TI Design are its low input voltage offset and low input bias current, which allows use of high value resistors, and rail-to-rail operation on both input and output. Additionally, the LPV521 integrates EMI protection to reduce sensitivity to unwanted RF signals, which is useful for low-power designs because of their high impedance nodes.
2.2 **Comparators**

In this TI Design, it is necessary to convert the amplified and filtered version of the sensor output into digital signals, which can be used as inputs to the MCU. To accomplish this, a window comparator circuit is used.

The low current consumption of only 75 nA (typical) per comparator makes the TLV3691 in this TI Design ideal. Other considerations for the comparator in this reference design include its low input voltage offset and low input bias current. Additionally, the TLV3691 features a rail-to-rail input stage with an input common mode range, which exceeds the supply rails by 100 mV, thereby preventing output phase inversion when the voltage at the input pins exceed the supply. This translates not only into robustness to supply noise, but also maximizes the flexibility in adjusting the window comparator thresholds in this design.

2.3 **Ultra-Low-Power Wireless MCU**

In this TI Design, transmitting the sensor information to some central location for processing is necessary. However, because power consumption is always a concern in battery-based applications, the radio and processor must be low power. Also, the wireless protocol required for the end-equipment system is an important consideration for the selection of the radio device.

With TI’s SimpleLink ultra-low-power wireless MCU platform, low power with a combined radio and MCU enables an extremely long battery life for sensor end-nodes. Furthermore, the CC2650 is a multi-standard device with software stack support for Bluetooth® Smart, ZigBee, 6LoWPAN, and ZigBee RF4CE. In this TI Design, the Bluetooth® Smart protocol is the protocol of choice, but the hardware as built can work with other protocols as well.

2.4 **Coin Cell Battery**

The power source for this TI Design is a CR2032 lithium-ion coin cell. The selection of the CR2032 coin cell battery as the power source was due to the ubiquity of that battery type, particularly in small form factor systems such as a sensor end-node.

The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage remains relatively flat throughout the discharge life until the cell is nearly depleted. When the cell is depleted, the output voltage drops off relatively quickly.

The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells, particularly at lower temperatures. This superiority is due to lithium-ion cells having a non-aqueous electrolyte that performs better than aqueous electrolytes commonly found in alkaline batteries. However, the CR2032 coin cell battery is still the limiting component in terms of the operating temperature range; all of the integrated circuits and other electrical components are specified to operate at a wider temperature range than the battery. Therefore, the specified operating temperature range of the TI Design system is −30°C to 60°C. Given an appropriate weather-proof enclosure, this TI Design system is suited for both indoor and outdoor use.

Immediately following the battery is a low $R_{DS(on)}$ P-channel MOSFET and a bulk capacitor. The P-channel MOSFET prevents damage to the hardware if the coin cell battery is inserted backwards while minimizing the forward voltage drop in normal operation. The bulk capacitor is sized to prevent too much voltage droop, particularly during the transitions into the MCU on-state for radio transmissions.
2.5 PIR Sensor

The sensor chosen for the TI Design is the Murata IRS-B210ST01 PIR sensor. The choice of this sensor was due to the fact that it is in a surface mount package and provides an analog output so that the low-power circuit in this TI Design could be demonstrated in an area efficient footprint.

While the test results collected for this TI Design are focused on a particular PIR sensor part number, it is expected that similar results can be obtained with any similarly specified PIR sensor that is available when the techniques and circuit designs demonstrated in this TI Design are applied.

Lastly, for any PIR sensor, it is necessary to use a lens in front of the sensor to extend the detection range by focusing the infrared energy onto the sensor elements. Using a Fresnel lens, the infrared image for the viewing area is spread across all of the sensor elements. The lens shape and size, therefore, determines the overall detection angle and viewing area. For this TI Design, the Murata IML-0669 lens is used so that a maximum field of view and detection range could be demonstrated. Ultimately, the choice of lens will be determined by the field of view angle and detection range required by the application.
3 Block Diagram

Figure 1. Wireless PIR System Block Diagram

3.1 Highlighted Products

The Low-Power PIR Motion Detector reference design features the following devices:

- LPV521 (Section 3.1.1): NanoPower, CMOS input, rail-to-rail IO operational amplifier
- TLV3691 (Section 3.1.2): NanoPower, CMOS input, rail-to-rail input comparator
- CC2650 (Section 3.1.3): SimpleLink multi-standard 2.4-GHz ultra-low-power wireless MCU

For more information on each of these devices, see their respective product folders at www.ti.com.
3.1.1 LPV521

Features:

- For $V_S = 5\, \text{V}$, typical unless otherwise noted
  - Supply current at $V_{CM} = 0.3\, \text{V}$ 400 nA (Max)
  - Operating voltage range: 1.6 to 5.5 V
  - Low $TCVOS = 3.5\, \mu\text{V/°C}$ (max)
  - $VOS = 1\, \text{mV}$ (max)
  - Input bias current: 40 fA
  - PSRR: 109 dB
  - CMRR: 102 dB
  - Open-loop gain: 132 dB
  - Gain bandwidth product: 6.2 kHz
  - Slew rate: 2.4 V/ms
  - Input voltage noise at $f = 100\, \text{Hz}$ 255 nV/√Hz
  - Temperature range: $-40\,\text{°C}$ to $125\,\text{°C}$

Applications:

- Wireless remote sensors
- Powerline monitoring
- Power meters
- Battery-powered industrial sensors
- Micropower oxygen sensor and gas sensor
- Active RFID readers
- Zigbee-based sensors for HVAC control
- Sensor network powered by energy scavenging

---

The LPV521 is a single nano-power 552-nW amplifier designed for ultra-long life battery applications. The operating voltage range of 1.6 V to 5.5 V coupled with typically 351 nA of supply current make it well suited for RFID readers and remote sensor nano-power applications. The device has input common mode voltage 0.1 V over the rails, guaranteed $TCVOS$ and voltage swing to the rail output performance. The LPV521 has a carefully designed CMOS input stage that outperforms competitors with typically 40 fA $IBIAS$ currents. This low input current significantly reduces $IBIAS$ and $IOS$ errors introduced in megohm resistance, high impedance photodiode, and charge sense situations. The LPV521 is a member of the PowerWise™ family and has an exceptional power-to-performance ratio.

The wide input common-mode voltage range, guaranteed 1 mV $VOS$ and 3.5 $\mu\text{V/°C}$ $TCVOS$ enables accurate and stable measurement for both high-side and low-side current sensing.

EMI protection was designed into the device to reduce sensitivity to unwanted RF signals from cell phones or other RFID readers.

The LPV521 is offered in the 5-pin SC70 package.
3.1.2 TLV3691

Features:
- Low quiescent current: 75 nA
- Wide supply:
  - 0.9 to 6.5 V
  - ±0.45 to ±3.25 V
- Micro packages: DFN-6 (1 × 1 mm), 5-pin SC70
- Input common-mode range extends 100 mV beyond both rails
- Response time: 24 µs
- Low input offset voltage: ±3 mV
- Push-pull output
- Industrial temperature range: –40°C to 125°C

Applications:
- Overvoltage and undervoltage detection
- Window comparators
- Overcurrent detection
- Zero-crossing detection
- System monitoring:
  - Smart phones
  - Tablets
  - Industrial sensors
  - Portable medical

The TLV3691 offers a wide supply range, low quiescent current 150 nA (maximum), and rail-to-rail inputs. All of these features come in industry-standard and extremely small packages, making this device an excellent choice for low-voltage and low-power applications for portable electronics and industrial systems.

Available as a single channel, the low-power, wide supply, and temperature range makes this device flexible enough to handle almost any application from consumer to industrial. The TLV3691 is available in SC70-5 and 1×1-mm DFN-6 packages. This device is specified for operation across the expanded industrial temperature range of –40°C to 125°C.
3.1.3 CC2650

Features:

- Microcontroller:
  - Powerful ARM Cortex-M3
  - EEMBC CoreMark score: 142
  - Up to 48-MHz clock speed
  - 128KB of in-system programmable flash
  - 8KB of SRAM for cache
  - 20KB of ultralow-leakage SRAM
  - 2-pin cJTAG and JTAG debugging
  - Supports over-the-air upgrade (OTA)

- Ultralow-power sensor controller:
  - Can run autonomous from the rest of the system
  - 16-Bit architecture
  - 2KB of ultralow-leakage SRAM for code and data

- Efficient code size architecture, placing drivers, Bluetooth Low Energy (BLE), IEEE 802.15.4 MAC, and Bootloader in ROM

- RoHS-Compliant Packages:
  - 4-mm × 4-mm RSM VQFN32 (10 GPIOs)
  - 5-mm × 5-mm RHB VQFN32 (15 GPIOs)
  - 7-mm × 7-mm RGZ VQFN48 (31 GPIOs)

- Peripherals:
  - All digital peripheral pins can be routed to any GPIO
  - Four general-purpose timer modules (eight 16-bit or four 32-bit timers, PWM each)
  - 12-bit ADC, 200-ksamples/s, 8-channel analog MUX
  - Continuous time comparator
  - Ultralow-power analog comparator
  - Programmable current source
  - UART
  - 2× SSI (SPI, MICROWIRE, TI)
  - i²C
  - I2S
  - Real-time clock (RTC)
  - AES-128 security module
  - True random number generator (TRNG)
  - 10, 15, or 31 GPIOs, depending on package option
  - Support for eight capacitive-sensing buttons
  - Integrated temperature sensor

- External system:
  - On-chip internal DC-DC converter
  - Very few external components
  - Seamless integration with the SimpleLink™ CC2590 and CC2592 range extenders
  - Pin compatible with the SimpleLink CC13xx in 4-mm × 4-mm and 5-mm × 5-mm VQFN packages
• Low power:
  – Wide supply voltage range:
    • Normal operation: 1.8 to 3.8 V
    • External regulator mode: 1.7 to 1.95 V
  – Active-mode RX: 5.9 mA
  – Active-mode TX at 0 dBm: 6.1 mA
  – Active-mode TX at 5 dBm: 9.1 mA
  – Active-mode MCU: 61 µA/MHz
  – Active-mode MCU: 48.5 CoreMark/mA
  – Active-mode sensor controller: 8.2 µA/MHz
  – Standby: 1 µA (RTC running and RAM/CPU retention)
  – Shutdown: 100 nA (wake up on external events)
• RF section:
  – 2.4-GHz RF transceiver compatible with BLE 4.1 specification and IEEE 802.15.4 PHY and MAC
  – Excellent receiver sensitivity (–97 dBm for BLE and –100 dBm for 802.15.4), selectivity, and blocking performance
  – Link budget of 102 dB/105 dB (BLE/802.15.4)
  – Programmable output power up to 5 dBm
  – Single-ended or differential RF interface
  – Suitable for systems targeting compliance with worldwide radio frequency regulations:
    • ETSI EN 300 328 (Europe)
    • EN 300 440 Class 2 (Europe)
    • FCC CFR47 Part 15 (US)
    • ARIB STD-T66 (Japan)
• Tools and development environment:
  – Full-feature and low-cost development kits
  – Multiple reference designs for different RF configurations
  – Packet sniffer PC software
  – Sensor controller studio
  – SmartRF™ Studio
  – SmartRF Flash Programmer 2
  – IAR Embedded Workbench® for ARM
  – Code Composer Studio™
Figure 3. CC2650 Functional Block Diagram

The CC2650 is a wireless MCU targeting Bluetooth Smart, ZigBee® and 6LoWPAN, and ZigBee RF4CE remote control applications.
The device is a member of the CC26xx family of cost-effective, ultralow power, 2.4-GHz RF devices. Very low active RF and MCU current and low-power mode current consumption provide excellent battery lifetime and allow for operation on small coin cell batteries and in energy-harvesting applications.

The CC2650 device contains a 32-bit ARM Cortex-M3 processor that runs at 48 MHz as the main processor and a rich peripheral feature set that includes a unique ultralow power sensor controller. This sensor controller is ideal for interfacing external sensors and for collecting analog and digital data autonomously while the rest of the system is in sleep mode. Thus, the CC2650 is ideal for applications within a whole range of products including industrial, consumer electronics, and medical.

The BLE controller and the IEEE 802.15.4 MAC are embedded into ROM and are partly running on a separate ARM Cortex-M0 processor. This architecture improves overall system performance and power consumption and frees up flash memory for the application.

The Bluetooth Smart and ZigBee stacks are available free of charge from www.ti.com.
4 System Design Theory

The Low-Power PIR Motion Detector with Bluetooth® Smart and 10-Year Coin Cell Battery Life Reference Design senses motion by detecting differences in infrared (IR) energy in the field of view of the sensor. Because the sensor output is a very small signal, amplification and filtering are necessary to boost the signal and at the same time filter noise so that a representation of the sensor output at a reasonable signal level is obtained while also minimizing false trigger events. The scaled analog output is then converted to digital signals by a window comparator function whose outputs can be used as interrupts to the wireless MCU to save power by only waking up the MCU when it is needed. The following sections discuss the details of the design for these different circuit sections that make up the design’s overall subsystem.

4.1 PIR Sensor

To better understand the circuit, the user must understand how the PIR motion sensor operates. The PIR motion sensor consists of two or more elements that output a voltage proportional to the amount of incident infrared radiation. Each pair of pyroelectric elements are connected in series such that if the voltage generated by each element is equal, as in the case of IR due to ambient room temperature or no motion, then the overall voltage of the sensor elements is 0 V. Figure 4 shows an illustration of the PIR motion sensor construction.

![Figure 4. PIR Motion Sensor Illustration](image)

The lower part of Figure 4 shows the output voltage signal resulting from movement of a body with a different temperature than the ambient parallel to the surface of the sensor and through the field of view of both sensor elements. The amplitude of this signal is proportional to the speed and distance of the object relative to the sensor and is in a range of low millivolts peak to peak to a few hundred microvolts peak to peak or less. A JFET transistor is used as a voltage buffer and provides a DC offset at the sensor output.

Because of the small physical size of the sensor elements, a Fresnel lens is typically placed in front of the PIR sensor to extend the range as well as expanding the field of view by multiplying and focusing the IR energy onto the small sensor elements. In this manner, the shape and size of the lens determine the overall detection angle and viewing area. The style of lens is typically chosen based on the application and choice of sensor placement in the environment. Based on this information, for best results, the sensor should be placed so that movement is across the sensor instead of straight into the sensor and away from sources of high or variable heat such as AC vents and lamps.

Also note that on initial power up of the sensor, it takes up to 30 s or more for the sensor output to stabilize. During this “warm up” time, the sensor elements are adjusting themselves to the ambient background conditions. This is a key realization in designing this subsystem for maximum battery life in that the sensor itself must be continuously powered for proper operation, which means power cycling techniques applied to either the sensor or the analog signal path itself cannot be applied for proper operation and reliable detection of motion.
4.2 Analog Signal Path

The analog signal conditioning section is shown in the schematic in Figure 5. The first two stages in Figure 5 implement the amplified filter function whereas stage 3 implements the window comparator design. Components R9 and C22 serve as a low pass filter to stabilize the supply voltage at the input to the sensor and are discussed further in Section 4.3.

![Figure 5. PIR Motion Sensor Analog Signal Path Schematic](image)

Resistor R12 sets the bias current in the JFET output transistor of the PIR motion sensor. To save power, R12 is larger than recommended and essentially current starves the sensor. This comes at the expense of decreased sensitivity and higher output noise at the sensor output, which is a fair tradeoff for increased battery lifetime. Some of the loss in sensitivity at the sensor output can be compensated by a gain increase in the filter stages. Due to the higher gain in the filter stages and higher output noise from the sensor, carefully optimize the placement of the high frequency filter pole and the window comparator thresholds to avoid false detection.

4.2.1 Amplified Filter Design

Composed of stages 1 and 2 in Figure 5, the filter section implements a fourth order bandpass filter using simple poles. Each stage implements identical second order bandpass filter characteristics. The chosen cutoff frequencies for the bandpass filter are set to 0.7 and 10.6 Hz. The passband gain of each stage is 220 for an overall signal gain of ~90 dB and was chosen to maximize the motion sensitivity range for the sensor bias point being used. The data collected for motion sensitivity range at different sensor bias and gain settings is shown in Section 8.3.1.

Generally, the filter bandwidth should be wide enough to detect a person walking or running by the sensor. At the same time, the filter bandwidth should be narrow to limit the peak-to-peak noise at the output of the filter. In most cases, a bandwidth between 0.3 to 2 Hz is acceptable for this application; however, the use of simple poles means the filter Q is low, which leads to a large filter transition region. With the poles placed this close, the overall passband gain is reduced, which reduces sensitivity and increases the noise floor.

The low frequency cutoff is critical because it has a major effect on the system noise floor by limiting the overall impact of 1/f noise from the analog front end as well as setting the minimum speed of motion that the system can detect. The practical lower limit on the low frequency cutoff is due to capacitor sizing at 0.1 Hz. Due to the low bias current being used in the sensor for this design, the low frequency noise will be worse than a normal higher current design, which means the low frequency cutoff should be higher than 0.3 Hz. Given a practical range of the low frequency cutoff to be between 0.3 to 1 Hz, this design used a low frequency cutoff in the middle of this range.
The high frequency cutoff is mostly for reducing broadband noise. The range for its placement will be a decade higher than the low frequency cutoff up to the bandwidth limit set by the open loop bandwidth of the op amp being used. In this case, the LPV521 has a unity gain bandwidth (UGBW) of 6.2 kHz, which means for a maximum stage gain of 220, the bandwidth is limited to 28 Hz. Allowing for component tolerances and variation in the UGBW of the LPV521, a practical range for the high frequency cutoff is between 7 and 14 Hz. Again, the choice was made to use a high frequency cutoff in the middle of this range.

The first stage of the filter is arranged as a non-inverting gain stage. This provides a high impedance load to the sensor so its bias point remains fixed. Because this stage has an effective DC gain of one due to C33, the sensor output bias voltage provides the DC bias for the first filter stage. Feedback diodes, D1 and D2 provide clamping so that the op amps in both filter stages stay out of saturation for motion events which are close to the sensor. Equation 1 to Equation 3 show the gain and cutoff frequencies for this stage:

\[
\begin{align*}
    f_{\text{Low1}} &= \frac{1}{2\pi \times R_{11} \times C_{33}} = \frac{1}{2\pi \times 6.81 \text{k}\Omega \times 33 \mu\text{F}} = 0.71 \text{Hz} \\
    f_{\text{High1}} &= \frac{1}{2\pi \times R_{13} \times C_{34}} = \frac{1}{2\pi \times 1.5 \text{M}\Omega \times 0.01 \mu\text{F}} = 10.6 \text{Hz} \\
    |G_1| &= 1 + \frac{R_1}{R_{11}} = 1 + \frac{1.5 \text{M}\Omega}{6.81 \text{k}\Omega} = 221.26
\end{align*}
\]

Since the second stage is AC coupled to the first stage, it is arranged as an inverting gain stage. This allows the DC bias to be set to \(V_{\text{CC}}/2\) easily by connecting the center point of the divider string in the window comparator to the non-inverting input of the op amp in this filter stage. Because the peak-to-peak noise is present at the output of this stage, R15 is made as large as possible to minimize the dynamic current of the system. Equation 4 to Equation 6 show the gain and cutoff frequencies for this stage:

\[
\begin{align*}
    f_{\text{Low2}} &= \frac{1}{2\pi \times R_{14} \times C_{36}} = \frac{1}{2\pi \times 68.1 \text{k}\Omega \times 3.3 \mu\text{F}} = 0.71 \text{Hz} \\
    f_{\text{High2}} &= \frac{1}{2\pi \times R_{15} \times C_{41}} = \frac{1}{2\pi \times 15 \text{M}\Omega \times 1000 \text{pF}} = 10.6 \text{Hz} \\
    |G_2| &= \left| \frac{R_{15}}{R_{14}} \right| = \left| \frac{15 \text{M}\Omega}{68.1 \text{k}\Omega} \right| = 220.26
\end{align*}
\]

The total circuit gain (not including any gain reduction due to pole placement), is given by \(G_1 \times G_2 = 221.26 \times 220.26 = 48810 = 93.77 \text{ dB}\). Figure 6 and Figure 7 show simulation results for these two filter stages.
The responses shown in Figure 6 and Figure 7 illustrate the effect of finite unity gain bandwidth for the amplifiers in the circuit. Note that not only is the high frequency response altered, but also the attenuation at the high frequency cutoff is increased and the peak gain frequency is shifted slightly.

### 4.2.2 Window Comparator Design

The window comparator circuit shown in stage 3 of Figure 5 converts the analog output of the filter to digital signals, which are used as interrupts to the MCU to tell it when motion has been detected. Composed of resistors R18 through R21, the resistor divider sets up the thresholds that determine a valid motion detection from the sensor. To save power, this resistor divider also provides the bias voltage for the second stage of the filter. Capacitors C38, C46, and C47 are necessary to stabilize the threshold voltages to prevent chatter at the output of the comparators. These capacitors do not need to be a large value due to the large resistors being used in the resistor divider, but they should be low ESR and low leakage, with ceramic being preferred. The comparator chosen for this reference design is the TLV3691 due to its ultra-low supply current requirements. The TLV3691 comparator also has rail-to-rail input capability with an input common mode range that exceeds the supply rails by 100 mV. This is not required for this design, but it does allow the ability to maximize the adjustment range of the window comparator thresholds. The comparator outputs will be low when there is no motion detected. Typically, motion across the sensor will generate a high pulse on one comparator output followed by a high pulse on the other comparator, which corresponds to the amplification of the S-curve waveform shown in the lower part of Figure 4. Which comparator triggers first will depend on the direction of the motion being detected.

Equation 7 and Equation 8 are used to adjust the window comparator thresholds:

\[
V_{\text{REF\_High}} = V_{\text{CC}} \frac{R19 + R20 + R21}{R18 + R19 + R20 + R21} = 0.75 \times V_{\text{CC}}
\]  

\[
V_{\text{REF\_Low}} = V_{\text{CC}} \frac{R21}{R18 + R19 + R20 + R21} = 0.25 \times V_{\text{CC}}
\]  

There is also a constraint that R18 + R19 = R20 + R21 so that the V_{\text{CC}}/2 bias level is maintained at the center tap of the divider for use as the bias for the second stage of the filter.

The thresholds chosen for this design are a balance between sensitivity and noise immunity. Widening of the window improves noise immunity but reduces sensitivity. Making the window too small can lead to false triggers due to the peak-to-peak noise seen at the input to the window comparator.

### 4.3 Power Supply Design

Because of the increasing battery impedance over the life of the battery supply and the low power supply rejection of the PIR sensor, it is important to design the power supply network to prevent current spikes generated by the MCU from causing false triggers through the analog signal path. While the algorithm implemented in firmware helps to filter such problems, this unwanted power supply feedback loop can become an issue. Ideally, the sensor supply would be regulated to break this loop; however, in this design the extra quiescent current of a regulator would reduce battery life, so other methods were explored.

Figure 8 shows a simplified schematic of the power supply network. The PMOS transistor is used in place of the traditional Schottky diode for reversed battery protection. Because the peak currents are in the 30-mA range when the radio transmits, using a low R_{DS\_ON} PMOS provides a much lower voltage drop compared to a Schottky diode, which helps to maximize battery life by allowing the battery to decay to a lower voltage before the circuit is no longer able to function (for more on this technique, see SLVA139).

![Figure 8. PIR Motion Sensor Simplified Power Supply Network Schematic](image-url)
Capacitor C21 supplies the circuit during periods of high and fast peak current demand, which helps to maximize the battery capacity and minimize voltage droop on the power supply rail, especially as the battery approaches its end of life and its internal impedance increases (represented by $R_{\text{int}}$ in Figure 8). The calculation for C21 is provided in Equation 9. For more details on this calculation and the effects of high current peaks on battery life and capacity, see White Paper SWRA349.

$$C_{21} = \frac{\Delta Q}{V_{\text{MAX}} - V_{\text{MIN}}}$$  \hspace{1cm} (9)

where

$$\Delta Q = Q_{\text{dis}} - \frac{V_{\text{MIN}}}{R_{\text{int}}} t_{\text{tot}}$$

$$Q_{\text{dis}} = \sum i_n \times t_n$$

$V_{\text{MAX}}$ is the voltage across the capacitor at the start of the current pulse at the end of the battery’s life, and $V_{\text{MIN}}$ is the circuit operating minimum, which is the sensor minimum plus the voltage drop across $R_9$ due to the sensor bias current ($2\,\text{V} + 0.6\,\mu\text{A} \times 619\,k\Omega \sim 2.4\,\text{V}$). $V_{\text{MAX}}$ is taken to be 2.698 V assuming an unloaded end of life battery voltage of 2.7 V ($V_p$). Based on the measured current profile during a radio transmission, shown in Figure 21 and Equation 11:

$$Q_{\text{dis}} = 23.2\,\text{mA} \times 100\,\mu\text{s} + 4\,\text{mA} \times 3.5\,\text{ms} + 8.8\,\text{mA} \times 2.5\,\text{ms} = 38.32\,\mu\text{C}$$  \hspace{1cm} (10)

For C21:

$$C_{21} = \frac{38.32\,\mu\text{C} - \frac{2.4\,\text{V}}{1k\Omega} \times 6.1\,\text{ms}}{2.698\,\text{V} - 2.4\,\text{V}} = 79.5\,\mu\text{F}$$  \hspace{1cm} (11)

This design uses $C_{21} = 100\,\mu\text{F}$ and additional decades of capacitors in parallel for improved impedance at higher frequencies. The time required to recharge the composite $C_{21}$ capacitor after the high current event is given in Equation 12 and is sufficiently low compared to the active and standby states of the device where current consumption is in the low microamp range.

$$t = R_{\text{int}} \times C_{21} \times \ln \left( \frac{V_p - V_{\text{MIN}}}{V_p - V_{\text{MAX}}} \right) = 1k\Omega \times 111.514\,\mu\text{F} \times \ln \left( \frac{2.7\,\text{V} - 2.4\,\text{V}}{2.7\,\text{V} - 2.698\,\text{V}} \right) = 0.56\,\text{s}$$  \hspace{1cm} (12)

With the value of $C_{21}$ determined, $R_9$ and $C_{22}$ can be sized to prevent false triggers from occurring during high current events on the power supply. With $R_9$ chosen based on the acceptable amount of voltage drop due to the sensor bias, $C_{22}$ was determined experimentally. If desired, $R_9$ can be reduced in value to be able to operate at slightly lower voltage; however, the time constant for $R_9$ and $C_{22}$ shown in Figure 8 needs to be maintained. This means $C_{22}$ becomes larger and would require a different dielectric, which in all likelihood would be more leaky or more costly and negate some of the advantage to reducing $R_9$. Similar to what was done for $C_{21}$, $C_{22}$ has additional decades of capacitors in parallel to maintain a low impedance at higher frequencies.
4.4 Firmware Control

The flowchart shown in Figure 9 describes the CC2650 operation in this TI Design. The CC2650 first starts by checking the source of wake up. If the device is woken up by reset, the system is powered on for the first time. The CC2650 will wait in standby mode for two minutes to allow the PIR sensor and analog signal chain to power on and allow the operating point to settle. After two minutes, the firmware will look at the outputs of the window comparator. By default, the output of both comparators should be low. If either comparator output is high, the CC2650 will send an ERROR message and will wait an additional amount of time for the sensor to settle. Once the PIR sensor and analog signal chain are functioning correctly, the CC2650 will enter shutdown mode.

The CC2650 will stay in shutdown mode until the PIR sensor signals the MCU that motion is detected by means of the window comparator outputs serving as interrupts. When the CC2650 is woken up by the PIR sensor, it will send an ON packet to notify the host controller that motion has been detected. The CC2650 will wait in standby mode until the PIR sensor is silent for one minute before sending an OFF packet to the host controller and returning to shutdown mode.

Figure 9. Wireless PIR Firmware Flowchart
Figure 10 shows the hardware for the Low-Power PIR Motion Detector With Bluetooth Smart and 10-Year Coin Cell Battery Life TI Design. The printed circuit board (PCB) is in a 35×75-mm rectangular form factor and comes with 0.5-in nylon standoffs to ensure ease of use while performing lab measurements.

Figure 10. Low-Power Wireless PIR Motion Detector Reference Design Hardware Description

All the integrated circuits (CC2650, LPV521, and TLV3691), several test points, and jumpers are located on the top side of the PCB. The antenna is also located on the top side of the PCB.

The bottom side of the PCB contains the CR2032 coin cell battery holder, jumper J6, and the bottom half of the antenna.

There are four unused GPIOs that have been brought out from the CC2650 to an unpopulated header to facilitate future prototyping and debugging.
5.1 Jumper Configuration

To facilitate measuring critical parameters and debugging in this reference design, there are several jumpers included. However, to properly operate the design, these jumpers must be installed correctly. The jumper configuration for normal operation is as follows: J5 = Shorted, J1 = Open, J3 = Open, J6 = Shorted.

The jumper configuration to program the CC2650 is as follows: J5 = Open, J3 = Open, J6 = Don’t care, and J1 connected to the 10-pin ARM Cortex Debug Connector on the SmartRF06 Evaluation Board (EVM) through a ribbon cable. On the SmartRF06 EVM, set the source switch to “USB” and short the “VDD to EM” jumper. In this configuration, the SmartRF06 EVM provides power to the CC2650. See the SmartRF06 EVM documentation for more information (SWRU321).

See Figure 10 for a brief description of the intended function of these different jumpers.

5.2 Test Point Description

This design includes several test points to monitor critical signals. The following is a brief description of these test points:

- **TP1**: Filtered DC-DC converter output from the CC2650
- **TP2**: Filtered battery supply forming input to the DC-DC converter in the CC2650
- **TP3, TP4**: Ground points for probes or common points for voltage measurements
- **TP5**: Output of analog filter stage, which is also the input to the window comparator stage
- **TP6, TP7**: Window comparator high threshold and low threshold outputs, respectively

5.3 Battery Requirements

Only insert an Energizer CR2032VP Lithium battery or a battery with equivalent specifications:

- CR2032 UL certified battery
- Voltage: 3.0 V
- Min capacity: 240 mAh
- Min discharge rate: 0.19 mA

**NOTE:** The battery must be replaced by a trained professional.

5.4 Miscellaneous

Note that due to the number of sensitive high impedance nodes in this design, probing points aside from the ones with dedicated test points should be done so with the probe impedance in mind.

An example of this would be the probing of the reference inputs to the window comparator. Because these reference thresholds are generated from a resistor divider composed of four 15-MΩ resistors, using a standard oscilloscope probe or voltmeter with a 10-MΩ input impedance will effectively load the circuit being measured and provide a false measurement.
6 Getting Started: Firmware

6.1 Loading Firmware

The firmware used on this TI Design was developed using TI's Code Composer Studio software (version 6.1.0).

The IAR Embedded Workbench for ARM also supports the CC265x line of SimpleLink products.

The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J1 to the SmartRF06 EVM (10-pin ARM Cortex Debug Connector, P410). On the SmartRF06 EVM, set the source switch to "USB" and short the "VDD to EM" jumper. In this configuration, the SmartRF06 EVM provides power to the CC2650. See the SmartRF06 EVM documentation for more information (SWRU321). See Figure 11 for a photo of the correct setup for connecting the TI Designs hardware to the SmartRF06 EVM.

![Figure 11. Connection of SmartRF06 Evaluation Board and TI Designs Hardware for Programming and Debugging](image)

6.2 Receiving Data Packets

As this reference guide previously describes, this TI Design is programmed to detect a person’s presence by using the PIR sensor (see Section 2.5 and Section 4.1). The CC2650 will broadcast three possible action values:

- 0x00: Sensor powering up
- 0x11: Sensor active
- 0xEE: Error during startup of the sensor
- 0xAA: ON packet when the first motion is detected
- 0xFF: OFF packet one minute after the last motion is detected

To verify the proper operation of the radio transmission, two methods to view the transmitted packet are described in the following subsections.
6.2.1 Receiving Data Packets using CC2540EMK-USB and SmartRF Protocol Packet Sniffer

To verify the proper operation of the radio transmission, the CC2540EMK-USB CC2540 USB Evaluation Module Kit is used to ‘sniff’ packets using the SmartRF Protocol Packet Sniffer software. After installing the Packet Sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data transmissions:

1. Plug the CC2540EMK-USB into an unused USB port on the computer with the Packet Sniffer software installed.

2. Open the Packet Sniffer software; choose "Bluetooth Low Energy" as the protocol and hit Start.

3. Click on the Radio Configuration tab and verify that "Advertising Channel 39" is selected.

4. Press the Play button on the top toolbar to initiate the packet capture process.

Figure 12. Packet Sniffer Software
5. There will likely be many other packets detected, probably from mobile phones and other devices that use the Bluetooth Smart protocol. To view only the packets sent from the TI Design hardware, it is necessary to apply a display filter. Figure 13 shows a sample display of what will be recorded with no filter applied. The highlighted row shows the desired data packet in the midst of other, undesired data packets.

![Figure 13. Packet Sniffer Software, Filterless Recording](image-url)
6. The appropriate filter checks for non-connectable advertisement packets with ADV_NONCONN AdvA field equal to 0x265026502650. In the Field Name, select ADV_NONCONN AdvA from the drop down options. Click the "First" button. Modify the filter condition to the correct address, hit "Add", and then click "Apply filter". An example filtered view is shown in Figure 14.

7. To export the captured, filtered packets, press the "Saves the current session" button on the toolbar, or pause the packet capture and click File → Save data…; either of these choices prompts to save the displayed data as a packet sniffer data (.psd) file.

8. Convert the .psd file to readable hex values with HexEdit software. A different hex editor can perform this function as well; however, the authors of this guide have not verified any other options.

9. Open the .psd file in the HexEdit software. Click on Tools → Options. In the HexEdit Options window, click on Document → Display and change the Columns value to "271". Click Edit → Select All and Edit → Copy As Hex Text. Open a text editor program (for example, Notepad), paste the hex text, and save the text file. This text file can then be imported into Microsoft Excel® spreadsheet software for further analysis. For more information on the sniffer data packet format, click Help → User Manual on the packet sniffer software.
6.2.2 Receiving Data Packets using SmartRF06 Evaluation Board and CC2650 Evaluation Module

The second method uses the SmartRF06 Evaluation Board and the CC2650 Evaluation Module hardware to "sniff" the packets using SmartRF Studio. After installing the SmartRF Studio (v2.3.0 at the time of this writing), the procedure to detect the data transmissions is as follows:

1. Connect the CC2650 EVM to the EM header on the SmartRF06 evaluation board.
2. Verify that the following jumpers are populated: P483, P484, P485, and VDD TO EM.
3. Power on the SmartRF06 board.
4. Run the SmartRF Studio software.
5. Click on the Refresh button and verify that CC2650 is listed under the Connected devices window.
6. Click on the "2.4GHz" tab and double click on the CC2650.
7. Select the "BLE mode" radio option.
8. Change the BLE channel to 39 and select the target configuration that matches the CC2650 EVM.
9. Click the "Packet Rx" tab.
10. Check the "Infinite" box and leave all the other options as default.
11. Click the "Start" button.

The SmartRF Studio will capture all BLE advertising packets on channel 39 and display the packet information. Below is an example snapshot.

![SmartRF Studio Packet Sniffer Recording](image)

Figure 15. SmartRF Studio Packet Sniffer Recording
7 Test Setup

7.1 Overview

The Low-Power PIR Motion Detector with Bluetooth® Smart and 10-Year Coin Cell Battery Life reference design has been characterized to support all of the critical specifications for this sub-system. The following sections describe the test setups for these measurements including the equipment used and the test conditions unless otherwise noted.

7.2 Power Consumption

The power consumption measurements for this reference design were critical in balancing battery lifetime with sensor bias current and motion sensitivity. An initial prototype was built that allowed measurement of the different current paths in the design as a preliminary analysis. The results from that prototype are shown in Section 8.1. Measurements of supply current were then performed on the reference design hardware, which confirmed the prototype measurements. Further characterization was done on the reference design hardware over the voltage range of the design. The test setup for the supply current measurements is illustrated in Figure 16.

![Figure 16. Test Circuit Used for Measuring Supply Current](image)

To compute the battery life, the radio transmission intervals also need to be characterized as these intervals have brief periods of high peak currents before settling to the low microamp current levels measured using the setup above. The measurement of the radio transmission interval involves using a current probe that interfaces to an oscilloscope, which can then be used to trigger on the high current events. Data from this interval is then exported to Microsoft Excel where analysis of the data can be performed. This setup is illustrated in Figure 17.

![Figure 17. Test Circuit Used for Measuring Supply Current During Radio Transmission Intervals](image)

7.3 Functional

The following subsections describe the tests for functionality under various environmental conditions. These tests generally verify the limits of operation for the subsystem.
In cases where only the functionality of the PIR motion sensor design was being tested, the test results were reused from the Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life TI Design (TIDA-00489). Both TI Designs use the same PIR motion sensor design, including schematic, layout, and BOM, which allows for the reuse of test results across both designs. Each of the following sections states if test data was reused from the Sub-1GHz version of this TI Design.

7.3.1 Temperature and Humidity Range

The Sub-1GHz TI Design (TIDA-00489) was stressed under temperature and humidity bias to ensure the design operates and does not produce false triggers under extremes of the targeted environment. The typical extended building environment temperature range is assumed to be 0°C to 50°C while additional testing was performed to test the limits of the design down to –30°C and up to 60°C. Similarly, the typical humidity range for a building environment is assumed to be 20% to 70%.

The chamber used for the temperature and humidity stress was the CSZ ZH322-H/AC Temperature/Humidity Chamber and a Vaisala HMP235 Humidity Probe to monitor humidity. A Watlow F-4 Controller was used to automate the testing. The reference design PCB was placed in the chamber with a new Energizer CR2032 lithium-ion coin cell battery installed. A CC1111 USB dongle was placed near the TI Design hardware inside the chamber and connected to a laptop outside of the chamber with a USB cable to monitor for false triggers during the test. Figure 18 shows a picture of the setup.

![Figure 18. Wireless PIR Motion Detector Temperature and Humidity Test Setup](image)

To prevent false detection due to rapid changes in ambient temperature and subsequent sensor settling, the temperature was slowly ramped during the test as would be expected in a typical operating environment. The test was started with a 10-minute soak at 25°C followed by a 1°C per minute ramp up to 50°C with a 5-minute soak, followed by a 5°C per minute ramp to 60°C, and back down to 50°C with a 5-minute soak at 50°C, followed by a 1°C per minute ramp down to 0°C with a 5-minute soak. At 0°C, a similar 5°C per minute ramp was applied down to –30°C and back up to 0°C with a 5-minute soak at 0°C, followed by a 1°C per minute ramp back up to 25°C.

Because of the physical construction of the chamber and its use of fans for air flow within the chamber, false triggers were observed during the temperature ramping periods. During the soaking periods, false triggering subsided over the entire temperature range tested, which proves the functionality of the design over the temperature extremes. This observation is common for PIR-based motion detectors and for this reason are generally not recommended for installation near ventilation. The only known way to prevent the false triggering during this test is to cover the sensor so it could not be affected by thermal gradients due to forced air flow and reflections off the walls of the chamber; however, this was not done as part of this measurement.
To prevent false detection due to rapid changes in humidity, the humidity was slowly ramped during the test as would be expected in a typical operating environment. The test consisted of applying a 1% per minute ramp from 20% to 70% and then back down to 20% with a 30-minute initial soak. The temperature was held at 45°C to prevent condensation; however, condensation was observed at 68% and higher humidity points.

The only anomaly observed during this test was at the point where condensation formed on the PCB, which produced false triggering. As the humidity dropped to a point where the PCB dried, the false triggering stopped and was not observed for the remainder of the test.

### 7.3.2 Motion Sensitivity

The motion sensitivity range of the Sub-1GHz TI Design (TIDA-00489) was measured by connecting a dual pulse stretcher design built on a generic prototyping PCB with LED outputs on each channel for visual indication. The inputs to the pulse stretcher are connected to the window comparator output test points of the reference design. Using this method, the PIR sensor was allowed to remain stationary at a fixed location while the LED’s indicate when motion is being detected. The pulse stretcher was powered using its own coin cell battery so that it does not interfere with or modify the operation of the PIR sensor being tested. The farthest distance at which reliable detection of motion was indicated was then measured and reported as the motion sensitivity. Pictures of this setup are shown in Figure 19.
7.3.3 Wireless RF Range

The range of the Wireless 2.4-GHz RF was measured using the SmartRF06 evaluation board and CC2650 EVM described in Section 6.2.2. For this test, the SmartRF06 board remained at a stationary location as the PIR PCB was moved away from the SmartRF06 board. While the PIR PCB was on the move, the PIR design was being reset at regular short intervals to make sure there were radio packets constantly being transmitted. The two boards were always in direct view of each other. The distance at which packets were no longer received was then measured.

7.3.4 RF Immunity

The immunity of the Sub-1GHz TI Design (TIDA-00489) with respect to radiated RF disturbances was measured according to IEC61000-4-3 with an extended low frequency range. The IEC standard is specified for a frequency range of 80 MHz to 1 GHz; however, this testing was extended down to 10 kHz to look for susceptibility in the design for disturbances closer to the pass band of the circuit.

The setup consisted of connecting the pulse stretcher board used in Section 7.3.2 to the window comparator outputs and monitoring the LEDs for activity with a camera inside the anechoic chamber. Additionally, a field strength probe was placed near the board under test for control and monitoring of the RF field strength level being tested. This test setup is shown in Figure 20.

![Figure 20. RF Immunity Test Setup](image)

The biconical antenna shown in Figure 20 was used for the frequency range from 30 MHz to 1 GHz in both the horizontal and vertical orientation (vertical orientation shown). For frequencies lower than 30 MHz, it was necessary to use a rod antenna in a single orientation.
8 Test Data

NOTE: Unless otherwise noted, the test data in the following sections were measured with the system at room temperature. All of the measurements in this section were measured with calibrated lab equipment.

8.1 Power Characterization

Table 2 shows the power consumption of the entire system when it operates in its shutdown and standby modes. These two modes relate to the modes described in Figure 9. The Delta column is used to determine the supply current increase between these two modes as this is the value that will be used in the battery life calculations. The highlighted row in Table 2 was included for informational purposes only. At this voltage, the sensor becomes too noisy and starts to generate false triggers. The current in shutdown mode at this voltage was only measured by programming the user mode to keep the MCU in shutdown and ignore interrupts, which is also why there is no data reported for Standby mode at this supply voltage level.

<table>
<thead>
<tr>
<th>Vcc (V)</th>
<th>SUPPLY CURRENT</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>SHUTDOWN</td>
<td>STANDBY</td>
<td>DELTA</td>
</tr>
<tr>
<td>3.8 V</td>
<td>1.71 µA</td>
<td>3.01 µA</td>
<td>1.30 µA</td>
</tr>
<tr>
<td>3.6 V</td>
<td>1.68 µA</td>
<td>2.86 µA</td>
<td>1.18 µA</td>
</tr>
<tr>
<td>3.4 V</td>
<td>1.65 µA</td>
<td>2.77 µA</td>
<td>1.12 µA</td>
</tr>
<tr>
<td>3.2 V</td>
<td>1.64 µA</td>
<td>2.84 µA</td>
<td>1.20 µA</td>
</tr>
<tr>
<td>3.0 V</td>
<td>1.61 µA</td>
<td>2.90 µA</td>
<td>1.29 µA</td>
</tr>
<tr>
<td>2.8 V</td>
<td>1.60 µA</td>
<td>2.95 µA</td>
<td>1.35 µA</td>
</tr>
<tr>
<td>2.6 V</td>
<td>1.58 µA</td>
<td>2.93 µA</td>
<td>1.36 µA</td>
</tr>
<tr>
<td>2.4 V</td>
<td>1.57 µA</td>
<td>3.50 µA</td>
<td>1.94 µA</td>
</tr>
<tr>
<td>2.2 V</td>
<td>1.56 µA</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>

One observation from Table 2 is that there is a slight positive dependence of shutdown current on the supply voltage, which is expected. However, this also suggests that battery life calculations based on average values will be conservative because the supply current decreases as the battery ages.

The values to be used in the battery life calculations from Table 2 are the average current over the range of battery voltages from 3.3 V to 2.4 V. The average current for Shutdown mode is 1.63 µA while the average current for Standby mode is 2.97 µA. The average Delta current between Shutdown and Standby mode is 1.34 µA.
The final part of the power characterization was to measure the high current interval during radio transmissions when changing modes. Figure 21 shows the event where the ON packet is sent.

![Figure 21. Radio Transmission Event Supply Current](image)

The average current calculation during radio transmission was measured on multiple PIR boards. The average current consumption was 1.57 mA over a total duration of 56.66 ms.

The data values highlighted in this section are used in the following section to calculate the expected battery life for different expected use conditions.
8.2 Battery Life Calculations

The computation of battery life for this reference design is complicated by the myriad of different applications and use conditions possible for this type of sensor node. The approach taken here computes the average between two different expected likely use conditions and the worst case use condition. These use conditions are described as follows:

- **Case 1: Worst case**: 10 motion events per hour for every hour for the life of the battery. Each of these motion events is a walk through event meaning that an interrupt is generated by a body moving through the field of view once, allowing the active timer to expire and re-enter Shutdown mode before the next event occurs.
- **Case 2: Busy room in an office environment case**: 14 hours in Shutdown, 10 hours with constant motion such that the active timer does not expire once activated.
- **Case 3: Room with intermittent motion during business hours case**: 14 hours in Shutdown, 10 hours with 10 motion events per hour every hour. Similar to Case 1, each of these events is a walk through event.

Another available knob in the optimization of battery life for this reference design is the active timer value. The default value in firmware is 1 minute. Since this value can be modified, the battery life for Case 1 and Case 3 are recalculated using a value of 30 seconds to show the expected improvement.

The equations for the expected battery life for the three cases in consideration are as follows.

**General lifetime equation:**

\[
\text{Lifetime (years)} = \frac{\text{Battery Capacity (mAh)}}{\text{Shutdown Current + Event Current (mA) \times \frac{1}{8760 \text{hr/yr}}} \times \text{Derating Factor}}
\]

where

- **Event Current** = \[\left(\text{Delta Current \times Active Mode Duty Cycle}\right) + \left(\text{Radio Transmission Current \times Duty Cycle}\right)\] \times \text{Number of Events}

**Case 1**

\[
\text{Lifetime} = \frac{240 \text{ mAH}}{1.63 \mu A + \left(\left(1.34 \mu A \times 60 \text{ s/event}\right) + \left(1.57 mA \times 56.66 \text{ ms/event} \times 2\right)\right) \times \frac{10 \text{ events/hr}}{3600 \text{ s/hr}}} \times \frac{1}{8760 \text{ hr/yr}} \times 0.85 = 9.92 \text{ years}
\]

**Case 2**

\[
\text{Lifetime} = \frac{240 \text{ mAH}}{1.63 \mu A + 1.34 \mu A \left(\frac{10 \text{ hours}}{24 \text{ hours}}\right) + \left(\left(1.57 mA \times 56.66 \text{ ms/event} \times 2\right) \times \frac{2 \text{ events/day}}{3600 \text{ s/hr}} \times \frac{24 \text{ hours}}{24 \text{ hours}}\right)} \times \frac{1}{8760 \text{ hr/yr}} \times 0.85 = 10.63 \text{ years}
\]

**Case 3**

\[
\text{Lifetime} = \frac{240 \text{ mAH}}{1.63 \mu A + \left(\left(1.34 \mu A \times 60 \text{ s/event}\right) + \left(1.57 mA \times 56.66 \text{ ms/event} \times 2\right)\right) \times \frac{10 \text{ events/hr}}{3600 \text{ s/hr}} \times \frac{10 \text{ hours}}{24 \text{ hours}}} \times \frac{1}{8760 \text{ hr/yr}} \times 0.85 = 12.07 \text{ years}
\]

The derating factor in these equations accounts for self aging of the battery. Based on these equations, the average expected battery lifetime for this reference design with the active timer set to 1 minute is 10.87 years. Re-calculating Case 1 and Case 3 with an active timer set to 30 seconds is 10.42 years and 12.37 years, respectively. The average expected battery life with an active timer value of 30 seconds is therefore 11.34 years. Inspecting Case 1, decreasing the active timer to 17 seconds or less will yield an estimated battery lifetime of at least 10 years.
8.3 Functional

The following subsections present the test results for different functional tests. In cases where only the functionality of the PIR motion sensor design was being tested, the test results were reused from the Low-Power PIR Motion Detector With Sub-1GHz Wireless Connectivity Enabling 10-Year Coin Cell Battery Life TI Design (TIDA-00489). Both TI Designs use the same PIR motion sensor design, including schematic, layout, and BOM, which allows for the reuse of test results across both designs. Each of the following sections states if test data was reused from the Sub-1GHz version of this TI Design.

8.3.1 Motion Sensitivity

The motion sensitivity was measured for multiple sensors with different bias conditions and two different gain settings. Table 3 summarize these measurement results. These tests used the 2.4-GHz and Sub-1GHz TI Design (TIDA-00489).

<table>
<thead>
<tr>
<th>SENSOR</th>
<th>SUPPLY CURRENT (IDLE)</th>
<th>V_{out} (DC)</th>
<th>MAX. DISTANCE (Av = 90 dB)</th>
<th>MAX. DISTANCE (Av = 70 dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS = 2.2 MΩ, RD = 1 MΩ</td>
<td>IRS-B210ST01</td>
<td>365 nA</td>
<td>0.78 V</td>
<td>20 ft</td>
</tr>
<tr>
<td>IRS-B340ST02</td>
<td>375 nA</td>
<td>0.764 V</td>
<td>25 ft</td>
<td>8 ft</td>
</tr>
<tr>
<td>IRA-E700ST0</td>
<td>500 nA</td>
<td>1.093 V</td>
<td>12 ft</td>
<td>4.5 ft</td>
</tr>
<tr>
<td>IRA-E712ST3</td>
<td>555 nA</td>
<td>1.204 V</td>
<td>13 ft</td>
<td>5 ft</td>
</tr>
<tr>
<td>RS = 1.3 MΩ, RD = 620 KΩ</td>
<td>IRS-B210ST01</td>
<td>594 nA</td>
<td>0.77 V</td>
<td>&gt; 30 ft</td>
</tr>
<tr>
<td>IRS-B340ST02</td>
<td>572 nA</td>
<td>0.744 V</td>
<td>27 ft</td>
<td>8 ft</td>
</tr>
<tr>
<td>IRA-E700ST0</td>
<td>838 nA</td>
<td>1.085 V</td>
<td>15 ft</td>
<td>5 ft</td>
</tr>
<tr>
<td>IRA-E712ST3</td>
<td>920 nA</td>
<td>1.178 V</td>
<td>17 ft</td>
<td>7.5 ft</td>
</tr>
</tbody>
</table>

The highlighted cell in Table 3 illustrates the motion sensitivity of the circuit configuration implemented in the 2.4-GHz and Sub-1GHz TI Designs.

8.3.2 Wireless RF Range

The wireless RF range was measured to be at least 54 meters in a typical office environment with a direct line of sight. A longer range could not be tested due to physical constraints imposed by the office building used for this test. Also, the transmit power on the CC2650 radio was set to 0 dBm.

This TI Design was able to successfully transmit data packets down the entire length of a 54-meter office building with minimal obstructions. However, radio performance will likely vary in the end-equipment environment because obstructions in the RF transmit path will reduce range. For full verification of the hardware transmitting characteristics of the TI Design, further testing with end-equipment context is required.
8.3.3 RF Immunity

The RF immunity of the Sub-1GHz TI Design (TIDA-00489) was measured to be 30 V/m over the entire 10-kHz to 1-GHz frequency range. Immunity at field strengths higher than this were not tested due to equipment limitations in the frequency range around 30 MHz. This level also corresponds to Class 3 in the IEC61000-4-3 standard.

The only anomaly observed during this test was at the singular frequency step of 728.5 MHz, where the passing immunity level dropped to 29.8 V/m in the horizontal antenna orientation. This drop was due to the wiring connection between the PIR PCB and the pulse stretcher board used for monitoring.

8.3.4 Vibration

Vibration was not tested on this reference design in any official capacity. Part of the reasoning for this is that finding vibration specifications on commercially available PIR motion detectors is difficult to find. Rudimentary vibration testing was performed in the lab using a Sub-1GHz reference board by beating on the desk on which the PIR was also resting and looking for false trigger events at the output of the window comparator. Based on this test, no false triggers were observed as long as the PCB did not physically move. While crude, this test does show that there is nothing systematic in the design itself that would cause false triggers in a normal application aside from the sensor construction itself.

A more informative test would include control over vibration frequency and amplitude with both of these being varied. The results of such a test would illustrate potential harmonic sensitivities to vibration. PCB orientation could also be varied as part of this test for a complete picture of the sensitivity to vibration for a given design in different installations. Because such an elaborate test would yield different results based on the physical enclosure that would finally house the PCB design, it was determined that this was beyond the scope of this reference design.

All PIR-based motion sensors are sensitive to vibration in some capacity due to the physical construction of the sensor as well as the way it naturally operates. Because the PIR sensor is built using thermopiles, these elements have a crystal structure, which exhibits a piezo-electric effect if the amplitude and frequency of vibration is such that the thermopiles themselves vibrate. A more prevalent effect is due to the entire sensor itself moving. Because a Fresnel lens enlarges the effective field of view of the sensor at substantial distances away from the sensor by focusing IR energy onto the small area of the sensor elements, any small movement of the sensor will result in large movements in the field of view. Due to background IR energy, the sensor output will not be able to distinguish between changes in IR energy due to motion with a static background or the background itself changing rapidly due to movements of the field of view. In other words, the detection of motion is relative. If the sensor is assumed to be perfectly static, motion detected will be relative to the sensor, however, motion will also be detected if the background is static but the sensor is moving. In both cases, the output is valid because there is motion, but the task of narrowing the output to what is desired falls upon the installation and enclosure design.
9   Design Files

9.1   Schematics

To download the schematics, see the design files at TIDA-00759.

Battery Connector & Reservoir Capacitors

Figure 22. Power and PIR Sensor Schematic
Wireless MCU Bypass Capacitors & DC-DC Passives

JTAG Programming Interface

User and Reset Switches

Figure 23. Wireless MCU Schematic
9.2 Bill of Materials

To download the bill of materials (BOM), see the design files at TIDA-00759.

### Table 4. Low-Power PIR Motion Detector With Bluetooth® Smart and 10-Year Coin Cell Battery Life Reference Design BOM

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESIGNATOR</th>
<th>QTY</th>
<th>VALUE</th>
<th>PARTNUMBER</th>
<th>MANUFACTURER</th>
<th>DESCRIPTION</th>
<th>PACKAGE REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PCB1</td>
<td>1</td>
<td></td>
<td>ISE4047</td>
<td>Any</td>
<td>Printed Circuit Board</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A1</td>
<td>1</td>
<td>3.6mVp-p</td>
<td>IRS-B210ST01-R1</td>
<td>MuRata</td>
<td>Pyroelectric Infrared Sensors for Reflow Soldering, 3.6mVp-p, SMD</td>
<td>4.7x4.7mm</td>
</tr>
<tr>
<td>3</td>
<td>BT1</td>
<td>1</td>
<td></td>
<td>BS-7</td>
<td>Memory Protection Devices</td>
<td>Battery Holder, CR2032, Retainer clip, TH</td>
<td>CR2032 holder</td>
</tr>
<tr>
<td>4</td>
<td>C4, C11</td>
<td>2</td>
<td>10uF</td>
<td>GRM188R60J106ME47D</td>
<td>MuRata</td>
<td>CAP, CERM, 10 µF, 6.3 V, +/- 20%, X5R, 0603</td>
<td>0603</td>
</tr>
<tr>
<td>5</td>
<td>C5, C6</td>
<td>2</td>
<td>12pF</td>
<td>GRM1555C1E120JA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 12 pF, 25 V, +/- 5%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>6</td>
<td>C7, C8, C9, C10</td>
<td>4</td>
<td>0.1uF</td>
<td>GRM155R70J104KA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 0.1 µF, 6.3 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>7</td>
<td>C13</td>
<td>1</td>
<td>0.1uF</td>
<td>GRM188R71E104KA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 0.1 µF, 25 V, +/- 10%, X7R, 0603</td>
<td>0603</td>
</tr>
<tr>
<td>8</td>
<td>C14</td>
<td>1</td>
<td>1uF</td>
<td>GRM155R61A105KE15D</td>
<td>MuRata</td>
<td>CAP, CERM, 1 µF, 10 V, +/- 10%, X5R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>9</td>
<td>C15, C16</td>
<td>2</td>
<td>1.2pF</td>
<td>GRM1555C1H1R2BA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 1.2 pF, 50 V, +/- 8.3%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>10</td>
<td>C17</td>
<td>1</td>
<td>12pF</td>
<td>GRM1555C1H120JA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 12 pF, 50 V, +/- 5%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>11</td>
<td>C18, C20</td>
<td>2</td>
<td>2200pF</td>
<td>C1005X7R1H222K</td>
<td>TDK</td>
<td>CAP, CERM, 2200 pF, 50 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>12</td>
<td>C21, C22</td>
<td>2</td>
<td>100uF</td>
<td>C3216X5R1A107M160AC</td>
<td>TDK</td>
<td>CAP, CERM, 100 µF, 10 V, +/- 20%, X5R, 1206_190</td>
<td>1206_190</td>
</tr>
<tr>
<td>13</td>
<td>C23</td>
<td>1</td>
<td>10µF</td>
<td>C1608X5R0J106M</td>
<td>TDK</td>
<td>CAP, CERM, 10 µF, 6.3 V, +/- 20%, X5R, 0603</td>
<td>0603</td>
</tr>
<tr>
<td>14</td>
<td>C24</td>
<td>1</td>
<td>10µF</td>
<td>GRM155R60J106ME44D</td>
<td>MuRata</td>
<td>CAP, CERM, 10 µF, 6.3 V, +/- 20%, X5R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>15</td>
<td>C25</td>
<td>1</td>
<td>1µF</td>
<td>C1608X7R1C105K</td>
<td>TDK</td>
<td>CAP, CERM, 1 µF, 16 V, +/- 10%, X7R, 0603</td>
<td>0603</td>
</tr>
<tr>
<td>16</td>
<td>C26</td>
<td>1</td>
<td>1µF</td>
<td>C1005X5R1A105K050BB</td>
<td>TDK</td>
<td>CAP, CERM, 1 µF, 10 V, +/- 10%, X5R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>17</td>
<td>C27, C28</td>
<td>2</td>
<td>0.1µF</td>
<td>C1005X7R1H104K050BB</td>
<td>TDK</td>
<td>CAP, CERM, 0.1 µF, 50 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>18</td>
<td>C29, C30</td>
<td>2</td>
<td>0.01µF</td>
<td>C1005X7R1C103K050BA</td>
<td>TDK</td>
<td>CAP, CERM, 0.01 µF, 16 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
</tbody>
</table>
Table 4. Low-Power PIR Motion Detector With Bluetooth® Smart and 10-Year Coin Cell Battery Life Reference Design BOM (continued)

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESIGNATOR</th>
<th>QTY</th>
<th>VALUE</th>
<th>PARTNUMBER</th>
<th>MANUFACTURER</th>
<th>DESCRIPTION</th>
<th>PACKAGE REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>19</td>
<td>C31, C37, C40, C43, C45</td>
<td>5</td>
<td>1000pF</td>
<td>C1005X7R1H102K</td>
<td>TDK</td>
<td>CAP, CERM, 1000 pF, 50 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>20</td>
<td>C32</td>
<td>1</td>
<td>100pF</td>
<td>C0402C101J3GACTU</td>
<td>Kemet</td>
<td>CAP, CERM, 100 pF, 25 V, +/- 5%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>21</td>
<td>C33</td>
<td>1</td>
<td>33uF</td>
<td>C2012X5R1A336M125AC</td>
<td>TDK</td>
<td>CAP, CERM, 33 µF, 10 V, +/- 20%, X5R, 0805</td>
<td>0805</td>
</tr>
<tr>
<td>22</td>
<td>C34</td>
<td>1</td>
<td>0.01µF</td>
<td>C1005X7R1E103K</td>
<td>TDK</td>
<td>CAP, CERM, 0.01 µF, 25 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>23</td>
<td>C35, C38, C39, C42, C44, C46, C47</td>
<td>7</td>
<td>0.1µF</td>
<td>C1005X7R1H104K</td>
<td>TDK</td>
<td>CAP, CERM, 0.1 µF, 50 V, +/- 10%, X7R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>24</td>
<td>C36</td>
<td>1</td>
<td>3.3µF</td>
<td>C1005X5R1A335K050BC</td>
<td>TDK</td>
<td>CAP, CERM, 3.3 µF, 10 V, +/- 10%, X5R, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>25</td>
<td>C41</td>
<td>1</td>
<td>1000pF</td>
<td>C1005C0G1E102J</td>
<td>TDK</td>
<td>CAP, CERM, 1000 pF, 25 V, +/- 5%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>26</td>
<td>D1, D2</td>
<td>2</td>
<td>75V</td>
<td>1N4148X-TP</td>
<td>Micro Commercial Components</td>
<td>Diode, Switching, 75 V, 0.3 A, SOD-523</td>
<td>SOD-523</td>
</tr>
<tr>
<td>27</td>
<td>E1</td>
<td>1</td>
<td>N/A</td>
<td>ANTEENNA_DN007A</td>
<td>N/A</td>
<td>Standoff, Hex. 0.5&quot;L #4-40 Nylon</td>
<td>Standoff</td>
</tr>
<tr>
<td>28</td>
<td>H1, H3, H5, H7</td>
<td>4</td>
<td>1902C</td>
<td>Keystone</td>
<td>Standoff</td>
<td>Machine Screw, Round, #4-40 x 1/4, Nylon, Philips panhead</td>
<td>Screw</td>
</tr>
<tr>
<td>29</td>
<td>H2, H4, H6, H8</td>
<td>4</td>
<td>NY PMS 440 0025 PH</td>
<td>B&amp;F Fastener Supply</td>
<td>SMD, 3-Leads</td>
<td>Header, 50mil, 5x2, Gold, TH</td>
<td>Header, 50mil, 5x2, Gold, TH</td>
</tr>
<tr>
<td>30</td>
<td>H9</td>
<td>1</td>
<td>IML-0669</td>
<td>MuRata</td>
<td>Lens, Ceiling Mount, TH</td>
<td>D12xH8.508mm</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>J1</td>
<td>1</td>
<td>GRPB052VWVN-RC</td>
<td>Sullins Connector Solutions</td>
<td>Header, 50mil, 5x2, Gold, TH</td>
<td>Header, 50mil, 5x2, Gold, TH</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>J3</td>
<td>1</td>
<td>TSW-102-07-G-S</td>
<td>Samtec</td>
<td>Header, 100mil, 2x1, Gold, TH</td>
<td>2x1 Header</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>J5, J6</td>
<td>2</td>
<td>87898-0204</td>
<td>Molex</td>
<td>Header, 2.54 mm, 2x1, Gold, R/A, SMT</td>
<td>Header, 2.54 mm, 2x1, R/A, SMT</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>L1</td>
<td>1</td>
<td>1500 ohm</td>
<td>BLM18HE152SN1D</td>
<td>MuRata</td>
<td>Inductor, Multilayer, Ferrite, 1500 ohm @ 100 MHz, 0.5 A, 0603</td>
<td>0603</td>
</tr>
<tr>
<td>35</td>
<td>L2</td>
<td>1</td>
<td>10uH</td>
<td>CKS2125100M-T</td>
<td>Taiyo Yuden</td>
<td>Inductor, Multilayer, Air Core, 15 nH, 0.3 A, 0.32 ohm, SMD</td>
<td>0805</td>
</tr>
<tr>
<td>36</td>
<td>L3</td>
<td>1</td>
<td>15nH</td>
<td>LQG15HS15NJ02D</td>
<td>MuRata</td>
<td>Inductor, Multilayer, Air Core, 2 nH, 0.3 A, 0.1 ohm, SMD</td>
<td>0402 polarized</td>
</tr>
<tr>
<td>37</td>
<td>L4</td>
<td>1</td>
<td>2nH</td>
<td>LQG15HS2N0S02D</td>
<td>MuRata</td>
<td>Inductor, Multilayer, Air Core, 15 nH, 0.3 A, 0.32 ohm, SMD</td>
<td>0402 polarized</td>
</tr>
</tbody>
</table>
Table 4. Low-Power PIR Motion Detector With Bluetooth® Smart and 10-Year Coin Cell Battery Life Reference Design BOM (continued)

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DESIGNATOR</th>
<th>QTY</th>
<th>VALUE</th>
<th>PARTNUMBER</th>
<th>MANUFACTURER</th>
<th>DESCRIPTION</th>
<th>PACKAGE REFERENCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>38</td>
<td>Q1</td>
<td>1</td>
<td>-20V</td>
<td>SI2323DS</td>
<td>Vishay-Siliconix</td>
<td>MOSFET, P-CH, -20 V, -3.7 A, SOT-23</td>
<td>SOT-23</td>
</tr>
<tr>
<td>39</td>
<td>R1, R5, R6, R10, R16, R17</td>
<td>6</td>
<td>0</td>
<td>CRCW04020000Z0ED</td>
<td>Vishay-Dale</td>
<td>RES, 0%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>40</td>
<td>R2</td>
<td>1</td>
<td>100k</td>
<td>CRCW0402100FKED</td>
<td>Vishay-Dale</td>
<td>RES, 100 k, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>41</td>
<td>R3, R7</td>
<td>2</td>
<td>47.5k</td>
<td>CRCW040247K5FKED</td>
<td>Vishay-Dale</td>
<td>RES, 47.5 k, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>42</td>
<td>R8</td>
<td>1</td>
<td>0</td>
<td>CRCW08050000Z0EA</td>
<td>Vishay-Dale</td>
<td>RES, 0%, 0.125 W, 0805</td>
<td>0805</td>
</tr>
<tr>
<td>43</td>
<td>R9</td>
<td>1</td>
<td>619k</td>
<td>CRCW0402619FKED</td>
<td>Vishay-Dale</td>
<td>RES, 619 k, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>44</td>
<td>R11</td>
<td>1</td>
<td>6.81k</td>
<td>CRCW04026K81FKED</td>
<td>Vishay-Dale</td>
<td>RES, 6.81 k, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>45</td>
<td>R12</td>
<td>1</td>
<td>1.30Meg</td>
<td>CRCW04021M30FKED</td>
<td>Vishay-Dale</td>
<td>RES, 1.30 M, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>46</td>
<td>R13</td>
<td>1</td>
<td>1.50Meg</td>
<td>CRCW04021M50FKED</td>
<td>Vishay-Dale</td>
<td>RES, 1.50 M, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>47</td>
<td>R14</td>
<td>1</td>
<td>68.1k</td>
<td>CRCW040268K1FKED</td>
<td>Vishay-Dale</td>
<td>RES, 68.1 k, 1%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>48</td>
<td>R15, R18, R19, R20, R21</td>
<td>5</td>
<td>15Meg</td>
<td>RMCF0805JT15M0</td>
<td>Stackpole Electronics Inc</td>
<td>RES, 15 M, 5%, 0.125 W, AEC-Q200 Grade 0, 0805</td>
<td>0805</td>
</tr>
<tr>
<td>49</td>
<td>S1, S2</td>
<td>2</td>
<td></td>
<td>B3U-1000P</td>
<td>Omron Electronic Components</td>
<td>SWITCH TACTILE SPST-NO 0.05A 12V</td>
<td>3x1.6x2.5mm</td>
</tr>
<tr>
<td>50</td>
<td>SH-J1, SH-J2, SH-J3</td>
<td>3</td>
<td>1x2</td>
<td>969102-0000-DA</td>
<td>3M</td>
<td>Shunt, 100mil, Gold plated, Black</td>
<td>Shunt</td>
</tr>
<tr>
<td>51</td>
<td>TP1, TP2, TP5</td>
<td>3</td>
<td>SMT</td>
<td>5015</td>
<td>Keystone</td>
<td>Test Point, Miniature, SMT</td>
<td>Testpoint_Keystone_Miniature</td>
</tr>
<tr>
<td>52</td>
<td>TP3, TP4</td>
<td>2</td>
<td>Black</td>
<td>5001</td>
<td>Keystone</td>
<td>Test Point, Miniature, Black, TH</td>
<td>Black Miniature Testpoint</td>
</tr>
<tr>
<td>53</td>
<td>TP6, TP7</td>
<td>2</td>
<td>Yellow</td>
<td>5004</td>
<td>Keystone</td>
<td>Test Point, Miniature, Yellow, TH</td>
<td>Yellow Miniature Testpoint</td>
</tr>
<tr>
<td>54</td>
<td>U1</td>
<td>1</td>
<td></td>
<td>CC2650F128RSMR</td>
<td>Texas Instruments</td>
<td>Ultra low-power ARM Cortex M3 2.4 GHz Radio MCU, RSM0032B</td>
<td>RSM0032B</td>
</tr>
<tr>
<td>55</td>
<td>U2, U3, U4, U5</td>
<td>4</td>
<td></td>
<td>TPD1E10B06DPYR</td>
<td>Texas Instruments</td>
<td>ESD in 0402 Package with 10 pF Capacitance and 6 V Breakdown, 1 Channel, -40 to +125 degC, 2-pin X2SON (DPY), Green (RoHS &amp; no Sb/Br)</td>
<td>DPY0002A</td>
</tr>
<tr>
<td>ITEM</td>
<td>DESIGNATOR</td>
<td>QTY</td>
<td>VALUE</td>
<td>PARTNUMBER</td>
<td>MANUFACTURER</td>
<td>DESCRIPTION</td>
<td>PACKAGE REFERENCE</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-----</td>
<td>-------</td>
<td>------------</td>
<td>--------------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>56</td>
<td>U6, U7</td>
<td>2</td>
<td></td>
<td>LPV521MG</td>
<td>Texas Instruments</td>
<td>Nanopower 400nA, 1.8V, R-R I/O CMOS Op Amp, DCK0005A</td>
<td>DCK0005A</td>
</tr>
<tr>
<td>57</td>
<td>U8, U9</td>
<td>2</td>
<td></td>
<td>TLV3691IDCKR</td>
<td>Texas Instruments</td>
<td>0.9-V to 6.5-V, Nanopower Comparator, DCK0005A</td>
<td>DCK0005A</td>
</tr>
<tr>
<td>58</td>
<td>Y1</td>
<td>1</td>
<td></td>
<td>TSX-3225 24.0000MF20G-AC3</td>
<td>Epson</td>
<td>Crystal, 24 MHz, 9 pF, SMD</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td>Y2</td>
<td>1</td>
<td></td>
<td>FC-12M 32.7680KA-A3</td>
<td>Epson</td>
<td>Crystal, 32.768kHz, 12.5pF, SMA</td>
<td></td>
</tr>
<tr>
<td>60</td>
<td>C1, C2</td>
<td>0</td>
<td>12pF</td>
<td>GRM1555C1E120JA01D</td>
<td>MuRata</td>
<td>CAP, CERM, 12 pF, 25 V, +/- 5%, C0G/NP0, 0402</td>
<td>0402</td>
</tr>
<tr>
<td>61</td>
<td>C3</td>
<td>0</td>
<td>Used in BOM report</td>
<td>Used in BOM report</td>
<td></td>
<td>CAP, CERM, xxxF, xxV, [TempCo], xx%, [PackageReference]</td>
<td>0603</td>
</tr>
<tr>
<td>62</td>
<td>C12, C19, C48</td>
<td>0</td>
<td>Used in BOM report</td>
<td>Used in BOM report</td>
<td></td>
<td>CAP, CERM, xxxF, xxV, [TempCo], xx%, [PackageReference]</td>
<td>0402</td>
</tr>
<tr>
<td>63</td>
<td>FID1, FID2, FID3, FID4, FID5, FID6</td>
<td>0</td>
<td>N/A</td>
<td>N/A</td>
<td>Fiducial mark. There is nothing to buy or mount.</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>64</td>
<td>J2</td>
<td>0</td>
<td></td>
<td>TSW-106-07-G-S</td>
<td>Samtec</td>
<td>Header, 100mil, 6x1, Gold, TH</td>
<td>6x1 Header</td>
</tr>
<tr>
<td>65</td>
<td>J4</td>
<td>0</td>
<td></td>
<td>CONSMA001-SMD-G</td>
<td>Linx Technologies</td>
<td>Jack, SMA, PCB, Gold, SMT</td>
<td>SMA Jack</td>
</tr>
<tr>
<td>66</td>
<td>R4</td>
<td>0</td>
<td>0</td>
<td>CRCW040200000Z0ED</td>
<td>Vishay-Dale</td>
<td>RES, 0, 5%, 0.063 W, 0402</td>
<td>0402</td>
</tr>
</tbody>
</table>
9.3 **PCB Layout Recommendations**

To ensure high performance, the Low-Power PIR Motion Detector With Bluetooth Smart and 10-Year Coin Cell Battery Life TI Design was laid out using a four-layer PCB. The second layer is a solid GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The top and bottom layers are used for general signal routing and also have GND fills in unused areas. For all of the TI products used in this TI Design, adhere to the layout guidelines detailed in their respective datasheets.

Additionally, because of the low-power design and the resulting high-impedance paths present in the design, keep the signal routes in the analog sensor path between the PIR sensor output and the window comparator input as short as possible with adequate GND fill around these signals.

If this design is to be used in an environment where dust or moisture accumulation is possible, be aware that it may be necessary to include a conformal coating to eliminate additional leakage paths due to the operating environment over time.

The antenna on this TI Design is the inverted F PCB antenna for 2.4-GHz transceivers and transmitters. See the application note DN0007 (*SWRU120*) for more details about layout and performance.

9.3.1 **Layer Plots**

To download the layer plots, see the design files at TIDA-00759.
Figure 30. Bottom Solder Mask

Figure 31. Bottom Overlay

Figure 32. Board Dimensions
9.4 Altium Project

To download the Altium project files, see the design files at TIDA-00759.

9.5 Layout Guidelines

Figure 33. Low-Power PIR Motion Detector Reference Design Layout Guidelines

Figure 34. DCD Routing Guidelines

For the integrated DC-DC converter in the CC2650, the input capacitors C11 and C13, inductor L2, and output capacitor C4 were placed such that a common ground area is used for the capacitors. The ground area had no ground vias and was directly connected to the ground pin on the CC2650.
Figure 35. Fabrication Drawing
9.7 Assembly Drawings

To download the assembly drawings, see the design files at TIDA-00759.

![Figure 36. Top Assembly Drawing](image1)

![Figure 37. Bottom Assembly Drawing](image2)

10 Software Files

To download the software files, see the design files at TIDA-00759.

11 References

3. Texas Instruments, *2.4 GHz Inverted F Antenna*, DN007 Application Report (SWRU120)
4. Texas Instruments WEBENCH® Design Center (http://www.ti.com/webench)

11.1 Trademarks

All trademarks are the property of their respective owners.

12 About the Authors

**DAVID STOUT** is a systems designer at Texas Instruments, where he is responsible for developing reference designs in the industrial segment. David has over 18 years of experience designing Analog, Mixed-Signal, and RF ICs with more than 14 years focused on products for the industrial semiconductor market. David earned his bachelor of science in electrical engineering (BSEE) degree from Louisiana State University, Baton Rouge, Louisiana and a master of science in electrical engineering (MSEE) degree from the University of Texas at Dallas, Richardson, Texas.

**CHRISTINA S. LAM** is a systems architect at Texas Instruments, where she is responsible for developing firmware for reference design solutions in the industrial segment. Christina has broad experience with applications processors, microcontrollers, and digital-signal processors with specialties in embedded firmware. Christina earned her bachelor of science (BS) in electrical and computer engineering from the University of Texas at Austin.

**GUSTAVO MARTINEZ** is a senior systems architect at Texas Instruments where he is responsible for developing reference designs for industrial applications. Gustavo has ample experience developing system reference designs for the Smart Grid and home automation segments, which include high performance application processors, floating-point digital signal processors, and RF technology. Gustavo obtained his master of electrical engineering degree from the University of Houston and his bachelor of science degree from the University of Texas at El Paso.
Revision B History

NOTE: Page numbers for previous revisions may differ from page numbers in the current version.

<table>
<thead>
<tr>
<th>Changes from A Revision (April 2016) to B Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Added Section 5.3: Battery Requirements</td>
<td>20</td>
</tr>
</tbody>
</table>

---

Revision A History

<table>
<thead>
<tr>
<th>Changes from Original (March 2016) to A Revision</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Changed from preview page</td>
<td>1</td>
</tr>
</tbody>
</table>

---
IMPORTANT NOTICE FOR TI REFERENCE DESIGNS

Texas Instruments Incorporated ("TI") reference designs are solely intended to assist designers ("Designer(s)") who are developing systems that incorporate TI products. TI has not conducted any testing other than that specifically described in the published documentation for a particular reference design.

TI’s provision of reference designs and any other technical, applications or design advice, quality characterization, reliability data or other information or services does not expand or otherwise alter TI’s applicable published warranties or warranty disclaimers for TI products, and no additional obligations or liabilities arise from TI providing such reference designs or other items.

TI reserves the right to make corrections, enhancements, improvements and other changes to its reference designs and other items. Designer understands and agrees that Designer remains responsible for using its independent analysis, evaluation and judgment in designing Designer’s systems and products, and has full and exclusive responsibility to assure the safety of its products and compliance of its products (and of all TI products used in or for such Designer’s products) with all applicable regulations, laws and other applicable requirements. Designer represents that, with respect to its applications, it has all the necessary expertise to create and implement safeguards that (1) anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that might cause harm and take appropriate actions. Designer agrees that prior to using or distributing any systems that include TI products, Designer will thoroughly test such systems and the functionality of such TI products as used in such systems.

Designers are authorized to use, copy and modify any individual TI reference design only in connection with the development of end products that include the TI product(s) identified in that reference design. HOWEVER, NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREBE, including but not limited to any patent right, copyright, mask work right, or other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information published by TI regarding third-party products or services does not constitute a license to use such products or services, or a warranty or endorsement thereof. Use of the reference design or other items described above may require a license from a third party under the patents or other intellectual property of TI.

TI REFERENCE DESIGNS AND OTHER ITEMS DESCRIBED ABOVE ARE PROVIDED “AS IS” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, INCLUDING BUT NOT LIMITED TO ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY DESIGNERS AGAINST ANY CLAIM, INCLUDING BUT NOT LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS AS DESCRIBED IN A TI REFERENCE DESIGN OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL, COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THE REFERENCE DESIGNS OR USE OF THE REFERENCE DESIGNS, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

TI’s standard terms of sale for semiconductor products (http://www.ti.com/sc/docs/stdterms.htm) apply to the sale of packaged integrated circuit products. Additional terms may apply to the use or sale of other types of TI products and services.

Designer will fully indemnify TI and its representatives against any damages, costs, losses, and/or liabilities arising out of Designer’s non-compliance with the terms and provisions of this Notice.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2016, Texas Instruments Incorporated